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Introduction

Welcome to the WinDupe on-line documentation and help file.    
WinDupe is a Windows 3.1 application and uses standard Windows 
techniques.    This document covers areas that are specific to 
WinDupe.    If you need information about using Windows, please refer
to your Microsoft Windows documentation.

Overview

WinDupe makes the chore of copying, comparing, and formatting 
diskettes a snap.    WinDupe loads an image of the selected diskette 
into memory by reading a track at a time, compressing the track, and 
storing it into memory.    The diskette will be loaded up to and including
the last track with data on it to provide the fastest possible load time.    
The diskette image can produce multiple copies of the original diskette 
or be saved to a disk file for future use.    The help menu lists several 
general help areas, including the help index and help commands.

Procedures

The initial execution of WinDupe provides two primary options --    the 
Load option and the Format option.    The Copy and Compare options 
will be disabled until a diskette image has    been successfully loaded 
into memory.    The File menu allows exit from the program.    Two 
secondary options are the Directory option and the View option. And, of
course, the Help option is enabled at all times.    

The Load option allows the loading of a diskette image by reading a 
diskette or by loading file from disk. 

The Copy option allows copying a diskette image to a diskette image or
to a disk file.    The diskette image may be copied to a diskette of the 
same or higher density.

The Compare option allows the diskette image in memory to be 
compared    to a diskette of the same or higher density.    If the diskette 
is the same density as the diskette image, then the diskette is 
compared track by track until the end of data in the diskette image is 



reached.    If the diskette is a higher density, then only the data area is 
compared until the end of data in the diskette image is reached.

The Format option allows a Quick Format without copying the operating
system (OS), a Quick Format with OS, a Full Format without OS, a Full 
Format with OS and just a transfer of the OS.    WinDupe makes use of 
the Input/Output Control (IOCTL) subfunctions to format diskettes.    
This allows direct communication with the device drivers to provide the
highest degree of compatibility possible.    The Quick Format simply 
initializes the boot sector, File Allocation Table, and Root Directory.    
The Quick Format option requires a diskette to have been previously 
formatted.

The Directory opton allows you to see what files are    on a diskette or 
in a stored diskette image prior to loading.    It will also allow you to see
what files are on your hard drive.

The View option allows you to toggle the state of the toolbar and status
bar.

WinDupe supports loading, copying, comparing, and formatting 360K, 
720K, 1.2M, 1.44M, and 2.88M diskettes.    

Compatibility

WinDupe requires Microsoft Windows 3.1.



WinDupe Commands
To get help with a particular command, choose the appropriate command.

 COMMAND                                MENU ITEM

File Exit
Load Diskette to Memory...

File to Memory...
Copy Memory to Diskette...

Memory to File
Compare Memory to Diskette...
Format Diskette...
Directory Disk...

File...
F1 = Help Index

Commands
Print Invoice...
About WinDupe...

The File Menu
The File menu allows you to exit the program.

Exit Exits WinDupe



Exits from WinDupe, releasing all memory allocated by any Load operations.



Load Diskette
The Load menu allows you to load a diskette image into memory from either
a diskette or a previously saved file.    Click any control to get more 
information.



Loads a diskette image from diskette into memory.    Select the Load All 
Tracks option if you desire to read all tracks. The default is to read only up to 
and including the last track containing data.



Loads a diskette image from a file previously saved by WinDupe into 
memory.



The Source listbox displays the diskette drives attached to your system.    To 
load a diskette, either doubleclick the desired diskette in the Source listbox. 
or select the icon corresponding to the diskette you want to load from, then 
press the OK button. To load a file from the Load Diskette Options dialog box,
either doubleclick on the file icon or select the file icon and press the OK 
button.



The Files listbox displays the files contained in the root directory of a diskette
or diskette image.    To display files, select an icon in the source listbox (do 
not doubleclick), then press the Dir button.



Pressing the ENTER key with the focus on the OK button or selecting the OK 
button with the mouse will begin the Load operation on the diskette selected 
in the source listbox.



Pressing the ENTER key with the focus on the CANCEL button or selecting the
CANCEL button with the mouse will cancel the Load operation and return you
to the main WinDupe window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the Load Diskette Options dialog box.    Help for the Load operation can also 
be displayed by pressing the F1 key when the Load Diskette Options dialog 
box is active.    If the Load Diskette Options dialog box is inactive, help for the
Load operation can be displayed by pressing the context sensitive help 
button on the toolbar, then selecting either the menu item for Diskette to 
Memory or the LOAD toolbar button.



Pressing the ENTER key with focus on the DIR key will display files in the Files
listbox for the diskette corresponding to the icon selected in the Source 
listbox.    This allows you to view what is contained in the root directory of the
selected diskette prior to loading the diskette into memory.



Checking Load Entire will read every track on the diskette.    The default is to 
read only up to and including the last track containing data.



Mouse

1.    Click the scroll arrows until the item you want to select appears in the
list box.

2.    Click the icon corresponding to the diskette you want to load and 
then choose the OK button.

Keyboard

1.    Use the tab keys until the source listbox has the focus.    
2.    Use the arrow keys until the icon corresponding to the diskette you 

want to load is highlighted.
3.    Press ENTER.



Load from File
The File to Memory option allows you to load a diskette image into memory
from a previously saved file.

File to Memory...

Loads a diskette image previously saved as a file by WinDupe into 
memory.    The diskette image must have been loaded from a diskette 
using Windupe and saved as a file from the Copy to File Dialog Box.    
Files with extensions other than .WDF or files that have not been saved
by WinDupe cannot be loaded    by WinDupe into memory.

The Select File dialog box enables you to select the filename of the 
diskette image previously.    The dialog box lists the files with the 
default extension WDF.    Once a file is selected (highlighted), the dialog
box will display disk size and capacity of the diskette whose image will 
be loaded in memory.    In addition, information about the WDF file will 
be displayed.    This includes size of the WDF file and date and time the 
WDF file was created.    To load a file, simply enter a filename on the 
FileName line or select a filename in the Files box and depress the 
ENTER key. 



Copy Diskette
The Copy menu allows you to copy the diskette image contained in memory 
to a diskette or to a file.    Click any control to get more information.



Copys a diskette image from memory to a diskette.    The target diskette may
be different than that of the source diskette according to the following table:

SOURCE                                  TARGET

360K 360K 720K 1.2M 1.44M 2.88M
720K 720K 1.2M 1.44M 2.88M
1.2M 1.2M 1.44M 2.88M
1.44M 1.44M 2.88M
2.88M 2.88M



Copies a diskette image from memory to a file.    The file should be saved 
with a WDF extension. 



The Target listbox displays the diskette drives attached to your system.    To 
copy to a diskette, either doubleclick the desired diskette in the Target 
listbox. or select the icon corresponding to the diskette you want to copy to, 
then press the OK button.    To save to a file from the Copy Diskette Options 
dialog box, either doubleclick on the file icon or select the file icon and press 
the OK button.



The Number of Copies option enables you to copy between 1 and 999 
diskettes in a single operation.    At the conclusion of each pass, a dialog box 
will display the number of the diskette copied and ask whether to continue    
the copy operation or terminate.



The target diskette will be formatted if Force Format is selected.    When the 
Force Format box is checked, a dialog box will appear that will afford the 
opportunity to format the target diskette to the desired density.    If the target
diskette is not formatted, WinDupe will attempt to format the target diskette 
based on the capacity of the target drive.    Therefore, if the source diskette is
a 360K diskette and the target diskette is an unformatted 720K diskette in a 
1.44Mb drive, WinDupe will attempt to format the target diskette as a 
1.44Mb diskette and the format operation will fail.    The Force Format option 
will afford the opportunity to select the desired format of the target diskette.



Pressing the ENTER key with the focus on the OK button or selecting the OK 
button with the mouse will begin the Copy operation on the diskette selected
in the source listbox.



Pressing the ENTER key with the focus on the CANCEL button or selecting the
CANCEL button with the mouse will cancel the Copy operation and return you
to the main WinDupe window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the Copy Diskette Options dialog box.    Help for the Copy operation can also 
be displayed by pressing the F1 key when the Copy Diskette Options dialog 
box is active.    If the Copy Diskette Options dialog box is inactive, help for the
Copy operation can be displayed by pressing the context sensitive help 
button on the toolbar, then selecting either the menu item for Diskette to 
Memory or the Copy toolbar button.



Copy to File
The Memory to File option allows you to load a diskette image into memory
from a previously saved file.

Memory to File...

Saves a diskette image to a disk file.    The Select File dialog box 
enables you to enter a description up to 30 characters of the diskette 
you wish to save to a file.    This will enable to you to quickly locate the 
diskette image when it comes to time to load it from disk into memory. 
The file may be saved to any disk, including diskettes.

Saving a diskette image is very easy.    Simply enter a filename on the 
FileName line and depress the ENTER key.    If the filename you have 
selected already exists, you will have the opportunity to change it if 
you wish.



Compare Diskette
The Compare menu allows comparing the diskette image in memory to a 
diskette.    Click any control to get more information.

Note:    If a device driver such as Stacker is enabled during the write 
operation,    a follow-on compare operation will most likely fail, even 
though the file data on the target diskette matches the source diskette.
This occurs because drivers such as Stacker sometimes update the 
target diskette during write operations.    These updates are to device 
driver areas of the diskette and do not affect    files copied to the target
diskette. 

Stacker is a registered trademark of STAC ELECTRONICS.



The Target listbox displays the diskette drives attached to your system.    To 
compare a diskette image in memory to a diskette, either doubleclick the 
desired diskette in the Target listbox. or select the icon corresponding to the 
diskette you want to copy to, then press the OK button.



Pressing the ENTER key with the focus on the OK button or selecting the OK 
button with the mouse will begin the Compare operation on the diskette 
selected in the source listbox.



Pressing the ENTER key with the focus on the CANCEL button or selecting the
CANCEL button with the mouse will cancel the Compare operation and return
you to the main WinDupe window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the Compare Diskette Options dialog box.    Help for the Compare operation 
can also be displayed by pressing the F1 key when the Compare Diskette 
Options dialog box is active.    If the Compare Diskette Options dialog box is 
inactive, help for the Compare operation can be displayed by pressing the 
context sensitive help button on the toolbar, then selecting either the menu 
item for Memory to Diskette or the Compare toolbar button.



Format Diskette
The Format menu allows the formatting of a brand new diskette or the 
reinitialization of a previously formatted diskette.    The Operating System can
also be transferred to the diskette.



The Quick Format option simply initializes the Boot Sector, the File Allocation 
Tables and the Root Directory.    The Quick Format will work only if the target 
diskette has been previously successfully formatted.

The Full Format option in addition to creating the Boot Sector, File Allocation 
Tables, and Root Directory,defines the sectors, to which data will be stored.    
The Full Format option will take significantly longer than the Quick Option 
because it has to write to and verify that write on every sector on the 
diskette.    

The Transfer System option will copy the Operating System to the target 
diskette to make it a bootable diskette.



Select the Media Size based on the following:

360K Double Sided Double Density 5.25 diskette
720K Double Sided Double Density 3.5 diskette
1.2M Double Sided High Density 5.25 diskette
1.44M Double Sided High Density 3.5 diskette
2,88M Double Sided Quadruple Density 3.5 diskette



The Target listbox displays the diskette drives attached to your system.    To 
format a diskette, either doubleclick the desired target diskette in the Target 
listbox. or select the icon corresponding to the diskette you want to copy to, 
then press the OK button.    The diskette will be formatted according to the 
checked media size option 



Pressing the ENTER key with the focus on the OK button or selecting the OK 
button with the mouse will begin the Format operation on the diskette 
selected in the source listbox.



Pressing the ENTER key with the focus on the CANCEL button or selecting the
CANCEL button with the mouse will cancel the Format operation and return 
you to the main WinDupe window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the Format Diskette Options dialog box.    Help for the Format operation can 
also be displayed by pressing the F1 key when the Format Diskette Options 
dialog box is active.    If the Format Diskette Options dialog box is inactive, 
help for the Format operation can be displayed by pressing the context 
sensitive help button on the toolbar, then selecting either the menu item for 
Diskette or the Format toolbar button.



Directory
The Directory options enables you to obtain a listing of files contained on a 
hard drive or diskette, or in a .WDF file containing a diskette image.



Diskette Directory
Obtain a directory listing of a diskette or hard drive by selecting the desired 
drive in the Drive listing box and then either double clicking the drive letter 
or selecting the Dir push button.



Identifies the available drives and diskettes from which to select.    To select a
drive or diskette, click with the mouse or TAB to the DRIVE listbox, then use 
the up/down arrow keys until the highlight is on the desired drive or diskette.



Identifies the available directories associated with the drive or diskette 
selected in the DRIVE listbox.    To select a directory, click with the mouse or 
TAB to the DIRECTORY listbox, then use the up/down arrow keys until the 
highlight is on the desired directory.



Displays the files associated with the highlighted disk and directory.    This 
listbox is for information only and does not accept any actions other than 
scrolling.



Displays the currently selected drive and directory.



Label Options

Displays, adds, changes or deletes the label name of a disk.

Button Function

Display Volume Label Displays the disk label or name of the drive 
selected in the Drive Listbox above the Drive 
Listbox.

Delete Volume Label Deletes the disk label or name of the drive 
selected in the Drive Listbox.

Change Volume Label Toggles an edit box which enables you to modify 
the disk label or name of the drive highlighted in 
the Drive Listbox.    Enter up to 11 characters in 
the edit box, then press the CHANGE button.    

Change Modifies the disk label or name of the drive 
selected in the Drive Listbox.    If the edit box is 
empty, the disk label will be deleted.    The new 
label will be displayed above the Drive Listbox.

Displays information of the drive selected in the DRIVE listbox similar to the 
following:



Displays information of the file selected in the FILES listbox similar to the 
following:



Attributes

Attributes are a specific characteristic that describes the properties of a file.   
Check or uncheck the property you want to change.    The change is effective 
when the box is checked.    The following are DOS file attributes:

System Used by the operating system and not listed by the DIR command.
Hidden Not listed by the DIR command.
Read-Only Cannot be written to or deleted.
Archive Changed since last backup.

Displays in the FILES listbox the files associated with the drive and directory 
selected in the DRIVE and DIRECTORY listboxes.



Cancels the DISK DIRECTORY dialog box and returns you to the main 
WinDupe window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the Disk Directory dialog box.    Help for the Directory operation can also be 
displayed by pressing the F1 key when the Disk Directory dialog box is 
active.    If the Disk Directory dialog box is inactive, help for the Directory 
operation can be displayed by pressing the context sensitive help button on 
the toolbar, then selecting the menu item for Disk.



File Directory
Obtain a directory listing of a .WDF file containing a diskette image by 
selecting the desired file in the File list box, then either double clicking on 
that file or selecting the Dir push button.    The file directory option is 
currently limited to displaying the only root directory of the    diskette image 
in the selected file.    Subdirectories currently cannot be displayed.



Displays the filename of the file highlighted in the FILES listbox.



Displays the currently selected drive and directory.



Displays the files with a .WDF extension in the currently selected drive and 
directory.



Identifies the available drives and directories    To select a drive or directory, 
click with the mouse or TAB to the DRIVES/DIRECTORIES listbox, then use the
up/down arrow keys until the highlight is on the desired drive or directory.



Displays in the FILES listbox the files contained in the root directory of the 
diskette image saved as the .WDF file highlighed in the FILES listbox.



Displays the file description entered when the file was saved.    This 
description can be up to 31 characters.



Displays in the FILES listbox the files associated with the .WDF file highlighed
in the FILES listbox.    The file directory option is currently limited to 
displaying the only root directory of the diskette image in the selected file.    
Subdirectories cannot currently be displayed.    In addition, only files saved 
with WinDupe using a .WDF extension are supported at this time. 



Cancels the FILE DIRECTORY dialog box and returns you to the main WinDupe
window.



Pressing the ENTER key with the focus on the HELP key will display help for 
the File Directory dialog box.    Help for the Directory operation can also be 
displayed by pressing the F1 key when the File Directory dialog box is active. 
If the File Directory dialog box is inactive, help for the Directory operation 
can be displayed by pressing the context sensitive help button on the 
toolbar, then selecting the menu item for File.



F1=Help
Help for WinDupe may be accessed two ways:

- Pressing F1 (when no menu is highlighted).    To exit the F1 = Help 
pulldown menu without taking any action, click or drag the mouse 
anywhere outside the menu, or press the Esc (escape) key.

- Using the Help pulldown menu:

The  Help pulldown menu brings up various types of help which make up the 
on-line documentation for WinDupe.

Index

Displays the help index.

Commands
 

Displays the complete list of menu commands.

Print Invoice

 Prints an invoice for registering    WinDupe.    If you are 
evaluating the shareware version of the program, and you intend
to make continued use of it, you are obligated to register the 
program.    Improvements to WinDupe can only be made if you 
support the shareware concept.    Shareware is not freeware or 
public domain software.    There are privileges and incentives to 
becoming a registered user.    Please read the README.DOC file 
for details.

About WinDupe...

Displays a dialog box containing the current program version, 
copyright notice and obligatory head-swelling credits for the 
author.



What is Shareware?
Shareware is copyrighted commercial software that you are allowed to try 
out before you make the purchase decision.    It is a marketing concept, not a 
type of software.

Shareware marketing is typically used when the author doesn't have a huge 
advertising budget.    High end software like Lotus 1-2-3, dBase IV, etc. may 
have advertising budgets of over a million dollars.    A full page 
advertisement in a magazine like PC Magazine can cost over $10,000 an 
issue.    Smaller software companies, like MaeDae Enterprises, usually don't 
have that type of advertising budget so shareware marketing is used.

Many people question whether software distributed via shareware is of as 
high a quality as the software they see advertised in commercial magazines. 
Good commercial advertising can sell almost any software regardless of its 
quality.    Shareware must be of equal or higher quality than commercially 
available software for users to register.    You, the user, have the opportunity 
to evaluate the shareware and find the real gems.    With commercial 
software, you purchase the software and then hope it works as advertised.    

Note:  Don't feel guilty about passing around copies of shareware.    You are helping the author distribute his 
software.    Even though shareware is commercial software, you are encouraged to pass around evaluation copies!



Registration Benefits
Registration benefits include:

1.    The latest version of    WinDupe with no additional information screens.
2.    Unlimited support - written or by phone.
3.    Low cost upgrades.
4.    Notification of enhancements.
5.    A Windows based installation program is included with the registered 
version of WinDupe.    It completely automates the installation process 
including the creation of a program group!

Note:    Shareware relies on you, the user, for its existence.    Your registration will help ensure WinDupe continues 
to improve.    When you register, please take the time to fill out the suggestion form.    We want WinDupe to 
evolve so it can better meet your needs.




